
Shipping Connector 
for Microsoft Dynamics 365 Business Central 

Quick-Start Setup Guide 
Sales Order shipping with UPS WorldShip 

I. Purpose of this document 

This guide will assist you with initial configuration of Shipping Connector to enable you to ship a package 

using UPS WorldShip and then apply the shipment details to a Sales Order in Microsoft Dynamics 365 

Business Central. 

This guide will demonstrate the minimal configuration required to enable the above scenario to be 

completed.  For an in-depth explanation and review of the Shipping Connector, options and usage 

please refer to the Shipping Connector User Manual and/or the context sensitive help on the Shipping 

Connector pages in Dynamics 365 Business Central. 

Please also see the following Quick Start guides: 

Sales Order shipping with FedEx Ship Manager 

Sales Order shipping with FedEx Ship Manager LTL 

Sales Order shipping with Stamps.com Internet Postage 

 

II. Overview 

The Shipping Connector manages the exchange of address and shipment information between Microsoft 

Dynamics 365 Business Central and Third-Party Shipping Software (e.g., UPS WorldShip, FedEx Ship 

Manager, Stamps.com Internet Postage, or other).  When an order is “Released” in Dynamics 365 

Business Central the ship-to address and shipping preferences are exported to a data cache on the 

shipping workstation (where the shipping software is installed).  The shipping software imports that 

information and the shipment is processed.  When a shipping label is created, the shipment details are 

written to the data cache and the Shipping Connector then relays the information back to the Dynamics 

365 Business Central server.   

All of that action is behind the scenes – you don’t see it.  What you do see is an ‘Apply Shipping’ action 

on the Sales Order page – when you press it the shipping details are applied to the Sales Order resulting 

in shipping charge and tracking information lines added to the order. 

The graphic below depicts the data exchange flow. 

http://shippingconnector365.com/library/ShippingConnectorUserManual.pdf
http://shippingconnector365.com/library/Quick_Start_Sales_Order_Shipping_FSM.pdf
http://shippingconnector365.com/library/Quick_Start_Sales_Order_Shipping_FSMLTL.pdf
http://shippingconnector365.com/library/Quick_Start_Sales_Order_Shipping_Stamps.pdf


 

In the sections that follow we will walk you through the steps required to configure Shipping Connector 

for first-time use and then we’ll process a shipment using UPS WorldShip. 

III. Installation & Registration 

First, you will need to publish and install the Shipping Connector extension app into your Dynamics 365 

Business Central system.  You can find Shipping Connector in the Microsoft AppStore or (for on-prem 

environments) you can download it from our website at https://shippingconnector365.com/download.  

After installation you will need to start a 30-day free trial to obtain a registration: 

- Open the Shipping Connector Setup page (type ‘Shipping Connector Setup’ in the Search box). 

- Click on the Registration option and then select the “Start 30-day Free Trial” action 

 

IV. Configure a Web Service Access Key (OnPrem Environments only) 

Skip this section if you are working in a Cloud/SaaS environment. 

The Shipping Connector Workstation application (which is installed and run on the shipping workstation 

- we’ll get to that below) communicates with Shipping Connector in Business Central via the Shipping 

Connector Web Service.   

To enable communication via web services Business Central requires authentication.   

Business Central supports two web service authentication methods – Credentialed and OAuth2. 

https://shippingconnector365.com/download


Credentials are only supported by the OnPrem environment, they use the Web Service Access Key. 

OAuth2 is required by the Cloud/SaaS environment (see the OAuth2 section below). 

To configure authentication, you must select a Business Central user account, create a Web Service 

Access Key, and add the Shipping Connector Permission Set to the account permissions. 

 (Complete details are available here).  For the purpose of this guide we’ll give the condensed version – 

follow these steps: 

In Dynamics 365 Business Central: 

- Choose the Search icon, enter Users, choose the related link, and then find the user account 

that you wish to use for web service data exchange. 

- In the Web Service Access section, select the Web Service Access Key field. 

- In the Set the Web Service Access Key window, select the Key Never Expires check box. 

- Choose the OK button. 

- The access key is automatically generated and appears in the Web Service Access Key field. 

- We will need the key below 

- Make sure the Shipping Connector Permission Set has been added to the user account 

permissions at the bottom of the Users dialog 

NOTE: In order to configure a Web Service Access Key you must be logged into Business Central 

under the account you wish to configure – Business Central will not allow you to configure a Web 

Service Access Key for other user accounts. 

V. Shipping Connector Setup (in Dynamics 365 Business Central)  

Next, you will need to configure a few options such that Shipping Connector knows how to place 

shipping charges onto a Sales Order. 

- Open the Shipping Connector Setup page (type ‘Shipping Connector Setup’ in the Search box) 

- Scroll down to the “Numbering” fast-tab 

- Set “Shipping Charges Type” to “G/L Account” 

- Set “Shipping Charges No.” to “40200” (or select an appropriate G/L income account) 

- Set “Tax Group Code” to “NONTAXABLE” (or select an appropriate tax group code) 

https://docs.microsoft.com/en-us/dynamics365/business-central/dev-itpro/webservices/web-services-authentication


While we’re on this page let’s also copy & save the Shipping Connector Web Services URL – we’ll need it 

in a later step. 

- Scroll down to the “Web Service” fast-tab 

- Copy the Web Service URL (double click to select all, then right-click and select Copy)  

 

- Save that value 

 

VI. Shipping Connector Workstation Setup 

Now we need to install the Shipping Connector Workstation application on the computer where UPS 

WorldShip (or other shipping software) is installed.  The Shipping Connector Workstation application 

manages information exchange between the shipping software and the Business Central server. 

- Download the application installer from https://shippingconnector365.com/download.   

Note: After downloading, make sure to “unblock” the file: 

o right-click on the file, select “Properties” 

o check the “Unblock” checkbox if it appears at the bottom of the dialog 

o select OK to close the Properties dialog 

- Run the Shipping Connector Workstation installer 

(choose the option to run the configuration utility when setup completes) 

When the Shipping Connector Workstation Configuration wizard appears, we’ll use it to setup a 

connection to the Business Central server.   

- In the Configurator select Web Services for the data exchange method 

- Select Next to move to the Web Services tab 

- Paste the URL you saved in the previous step into the Web Services URL field 

If OnPrem: 

- Select Authentication = Credentials 

- Enter the Web Services Account Username (do not include a domain name) for which you 

configured a Web Services Access Key 

- Enter the Web Services Access Key  

- Press the Verify Web Service button 

If SaaS: 

- Select Authentication = OAuth2 

- Select Hosting = Business Central/SaaS 

- Press the Verify Web Service button 

https://shippingconnector365.com/download


You will need to authorize using a Business Central Login Account that has sufficient permissions 

to interact with the web services.  If the account you select is not authorizes you will need to 

clear the stored authorization and try again with a different account. 

 

Note: If you are not guided to the account authorization dialog when you press the Verify Web 

Service button then you will need to authorize the Shipping Connector app in your Azure tenant.  

Please see the OAuth2 Configuration Guide for more information. 

 

Successful verification will be indicated and you will then be able to move to the next tab. 

 

 

- Press the Next button to move to the Companies tab 

- Select the companies with which you would like to exchange data 

 

  

- Press the Next button to move to the Schema tab 

The Schema tab is for informational purpose only – no changes can be made 

 

- Press the Next button to move to the Configuration tab 

The Shipping Connector Workstation configuration will be saved, confirmation will be displayed 

 

https://shippingconnector365.com/library/ShippingConnectorOAuth2Configuration.pdf


- Press the Next button to move to the Data Maps tab 

- Press the Copy button in the UPS WorldShip area 

This will copy the import/export maps into the UPS WorldShip configuration 

Note: UPS WorldShip supports a client/server installation mode.  If installing into a client/server 

environment the map configuration must be performed on the workstation acting as server. 

 

- Press the Next button to move to the Finish tab 

- Select the startup options 

- Press the Finish button - Shipping Connector Workstation will display in the System Tray 

  

  



VII. Configure UPS WorldShip for use with Shipping Connector 

Shipping Connector makes use of a UPS WorldShip built-in facility that enables exchange of 

data via ODBC.  To turn on data exchange do the following: 

- Open UPS WorldShip 

- Turn on the Export map 

Import-Export → Automatic Export →Export After Shipment Processing →More… → 

Select ‘Dynamics Export’ 

  

- Turn on the Keyed Import map 

Import-Export → Keyed Import → More… → Select ‘Dynamics Import’ 

The Keyed Import dialog will display. 



VIII. Process a Shipment 

We’re now ready to begin shipping – let’s process a shipment. 

- In Dynamics 365 Business Central open a Sales Order 

- If the Sales Order is currently Released you will need to Reopen it 

- In the Shipping and Billing fast-tab area set the Shipping Agent to UPS and the Shipping 

Agent Service to GROUND 

- Release the Sales Order 

It is the Release action that initiates data exchange to UPS WorldShip. 

Note the Sales Order number (in this example it is S-ORD101001) 

 

- On the shipping workstation hold down the Ctrl key and left click on the Shipping 

Connector tray icon – this will manually initiate data synchronization – which will pull 

over the shipping information from the Sales Order that was just released 

 

- In UPS WorldShip enter the Sales Order number into the Keyed Import dialog and press 

the Enter key 

  

The ship-to information and service options will auto populate  



- Enter a shipping weight (or place the package on an attached scale) 

- Press the Process Shipment button 

 

UPS WorldShip will now print a shipping label and export the shipping details to 

Shipping Connector.  The Shipping Connector tray icon will flash green, indicating that 

shipment information is being relayed back to Dynamics 365 Business Central. 

 

- Back to Business Central, on the Sales Order (#S-ORD10100) press the Shipping 

Connector ‘Apply Shipping’ action:  Actions → Shipping Connector → Apply Shipping 

Shipping Connector will now add the shipment information lines to the Sales Order. 

It will also populate the Package Tracking Number, Shipping Agent and Shipping Agent 

Service fields in the Shipping and Billing area. 

- The Sales Order is now ready to Post 

 

Congratulations, you have just shipped your first order. 



IX. Configure for Multi-package Shipments 

If you intend to ship multi-package shipments, then perform the following configuration. 

- Open the UPS WorldShip Profile Editor 

Tools > Create/Edit Profile 

- On the References tab mark all reference fields ‘Use on All Packages’ 

 

- Close and save the profile 

Enter a name for the profile (DEFAULT is a good choice). 

 

- Now configure the profile to load by default 

- Select the profile in the Shipper Preferences 

Tools > Shipper Editor > Shipper > Modify > Preferences > Profile 

 



X. More Information 

In this guide we have only touched on the basic feature of Shipping Connector – processing a 

shipment for a Sales Order.  There is a lot more to Shipping Connector including: 

- Address Verification 

- Rate Shopping 

- Rate Adjustments 

- Purchase Return Orders, Transfer Orders, Service Orders 

We invite you to check out the feature descriptions and in-depth guides available on our web 

site @ https://shippingconnector365.com/guides. 

Happy Shipping! 

https://shippingconnector365.com/guides

